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Technical Support Contact Information

Clinic Team Members - If you are experiencing difficulties using any of the AIM tools (e.qg. initial installation,
setup and day to day use) it is highly recommended that you consult the table of contents of the appropriate
user guide for support before contacting your assigned facilitator.

Facilitators - Similar to clinic users, facilitators should consult the table of contents of the appropriate user
guide for support before contacting their Regional Support Team member when experiencing difficulties
using any of the AIM tools. If you do not know who your Regional Support Team member is or your region
is currently without one, please contact the AIM Measurement Support Team at the email address below.

Faculty Members - Faculty members should consult the table of contents of the appropriate user guide for
support before contacting the AIM Measurement Support Team at the email address below.

Regional Support Team Members - Regional Support Team members should direct their technical issues
to the AIM Measurement Support Team at:

measurement@albertaaim.ca

(Kylie Kidd Wagner or Randy Campbell)

Please NOTE:

e To help us troubleshoot your issue better, please provide a detailed description of the problem(s) in
your email

e Emails received by the AIM Measurement Support Team will, in general, be responded to in the
order in which they are received

e Requestors should expect a response to their issue(s) within one week

e Inthe event that a solution to an issue requires greater exploration by the AIM Measurement Support
Team, the response will inform the requestor of those details

e All users should check the Alberta AIM Website periodically to ensure they have the most recently
updated copy of the appropriate user guide(s) - http://www.albertaaim.ca/measurment.html



mailto:measurement@albertaaim.ca
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Dashboard — Quick Reference

Refer to the appropriate section below for more details if required.

Initial Installation

1. Save the appropriate copy of the Dashboard.xls file (2003 or 2007) based on your version of Excel to
the same location as your AIMTracking.xls file (i.e. your AIM folder located on your C:\drive)

- Excel 1997 to 2003 users should use the 2003Dashboard.xls file
- Excel 2007 and newer users should use the 2007Dashboard.xls file
2. Ensure the Dashboard.xls file is renamed to “Dashboard” exactly

3. Ensure your Excel security settings are appropriate (refer to the appropriate section below based on
the version of Microsoft Excel you are using for more details)

Customizing Your Dashboard Settings

1. Open the Dashboard.xls file

2. Scroll down to the “Dashboard Settings”

Dashboard Settings

Delay Day Targets in Calendar Days No Show Targets as a Percentage
What is your target delay? 0 VWhat is your target Mo Show? I 0.0% _|
What is your tolerable delay? 7 Your tolerable No Show? 10.0%
What is too high? 21 What is too high? 20.0%
Activity vs. Demand Effective Date
What is a good difference? = The default date is today's date. If you change this date formula
What is a neutral difference? 0 you must change it each time the Dashhoard is used
What is a poor difference? -5 April 20, 2011

YELLOW fields are to be filled in with vour targets. PURPLE fields have formulas, but vou can override these calculations by typing on top

3. For each of the measures represented on the Dashboard customize your team’s targets for
improvement

NOTE:
- The Yellow fields MUST be filled in by the user with the team’s target values

- The Purple fields, on the other hand, contain default formulas. In the event the calculated
values are not suitable users can key in their own values

4. Save your changes



Populating the Dashboard

IMPORTANT: The Dashboard.xls file can only be connected to one AIMTracking.xls file at a time.
Take the following steps to download data from your AIMTracking.xls file into the Dashboard.xls file:
1. Ensure the Dashboard.xls file is named “Dashboard” exactly

2. Ensure the AlIMTracking.xls file of interest and the Dashboard.xlIs file are save to the same location
(e.g. I Coam )

3. Ensure both files are open
4. Inthe AIMTracking.xls file press Alt+F8

5. In the Macro window that appears select the Dashboard.xIs!Data2Dashboard program

Macro name:
Dashboard, «lsiDatazDashboard 5.3 k RUR ]
Cleanldp ~

ComeTolew

Dashboard. xls|DatazDashboard
DownloadAIMData

Y |Dashboard. xls!DropiFarmulaz

| |Hide_Teamwork_Tab
HideGenericl =
| | Hideenericz

4 |HideGeneric3

J{ |HideInkro

| |HideServiceCyeleData
1 | PopulatetlextSetup

£

1 Macrosin: | All Open warkbooks w

! Descripkion

Cancel

6. Press the Run button

7. The screen will flash while the program is running — once finished the Dashboard.xIs file should be
populated



8. Select the provider of interest from the “values apply to:” field (NOTE: you can change this field
multiple times to view different provider’s data)

AIM Dashboard: Clinic Name

Values apply to: |Clinic

i i i Provider 1 A
Time to Third Next Available |oves’ v
Calendar Days Change ErDViger; Show Change
Most Recent week #MNIA =ZNA p:md:;s H#NIA
1 week ago #A #MIA| Provider 7 #hA
2 weeks ago #IA 1|/ Pravider 8 - - ENIA
3 weeks ago #A 3 weeks ago HNA

Activity vs. Demand

Predicted Completed Week 2 weeks ago 3 weeks ago
Activity #NIA #NIA E#NIA #A
Demand #NIA #NIA #NIA #IA
Status™ #NIA #NIA #NIA #NIA

* This denetes the change in the team'’s status. Positive results mean a lower backlog, Megative results increased backlog

NOTE: your Dashboard Settings can be changed at this time if desired.

Interpreting the Dashboard Results

Refer to the Interpreting the Dashboard Results section below.



Initial Installation

1. Save the appropriate copy of the Dashboard.xls file (2003 or 2007) based on your version of Excel to
the same location as your AIMTracking.xIs file (i.e. your AIM folder located on your C:\drive)

- Excel 1997 to 2003 users should use the 2003Dashboard.xls file
- Excel 2007 and newer users should use the 2007Dashboard.xls file
2. Ensure the Dashboard.xls file is renamed to “Dashboard” exactly

3. Ensure your Excel security settings are appropriate (refer to the appropriate section below based on
the version of Microsoft Excel you are using for more details)

Microsoft Excel — Excel 1997 to 2003 Users

Option 1 — Your Security Settings Do Not Need to be Changed

- If you receive the following pop-up message when opening the Dashboard.xls file your security
settings do not need to be changed. They are already set to “Medium”.

- “Medium” Security means you will receive this same warning each time you open the
Dashboard.xls file.

- Similar to the other AIM tools, for the file to function properly always click Enable Macros for the
Dashboard.xls file.

NOTE: For any other file (i.e. non AIM files) from an unknown or un-trusted source, click Disable
Macros.

Security Warning @

"C:\AIM\Dashboard. xls™ contains macraos.

Macros may contain viruses, Itis usually safe to disable macros, but if the
macros are legitimate, you might lose some functionality.

Dizable Macros ] [ Enable Macros ] [ Mare Info




Option 2 - Your Security Settings Need to be Changed

- If you receive the following pop-up message when opening the Dashboard.xls file the security
settings in your Microsoft Office Excel need to be changed. They should be set to “Medium”.

Microsoft Excel [=5e]

Macros are disabled because the security level is set to High and a digitally signed Trusted Certificate is not
l k. attached to the macros, To run the macros, change the security level to a lower setting {not recommended), or
request the macros be signed by the author using a certificate issued by a Certificate Authority.

[= I Hide Help << J [ Cpen in Help Window

You may encounter this error for the following reasons:

1. Macro security is set to:
*  Very High and the application encounters & signed macro, but the macro was automatically disabled,
|z the following procedure to enable the macros
1 1, Select the Tools menu option and then select Macre and Security. In the resulting Security
dialog, set the security level to High by dicking the High radio button,
| 2. Close the file and any other instances of the application currently running on the computer {close

all applications that also use the application vou are currently running). i
1 2 Mimam #Hha fla 2azim amd avamine Hhe cartificste AF droek Aatzile 2md cat e Aharsus Fensk

To check on your settings, or to change them, follow these steps:

1. Open the Dashboard.xls file

2. Under the Tools menu, click Options

3. Click the Security tab

4. Under Macro Security, click Macro Security
5

Click the Security Level tab, and then select the security level you want to use. (Choose
Medium)

Close the file (save your changes)

o

Reopen the Dashboard.xls file and the new security level should be in effect

NOTE: once you change your security settings, they are changed for Microsoft Office Excel, not
just for the Dashboard.xls file. They will stay on “Medium” until set to another level.

Taking the steps above will cause Microsoft Office Excel to present you with the Security
Warning message (below) each time you open the Dashboard.xls file. Always click “Enable
Macros” for the Dashboard.xls file. For any other file (i.e. non AIM files) from an unknown or un-
trusted source, click “Disable Macros”.

Security Warning @

"C:VAIM\Dashboard, xls™ contains macros.

Macros may contain viruses. It is usually safe to disable macros, but if the
macros are legitimate, you might lose some functionality.

[ Digable Macros ] I Enable Macros I I Maore Info




Microsoft Excel 2007 Users

Unlike older versions of Microsoft Office Excel, those using Excel 2007 will need to create a Trusted
Location in order for the Dashboard.xls file to function properly.

What is a Trusted Location? A trusted location is typically a folder on your hard drive (C:\ drive) or
a network share. Any file placed in a trusted location can be opened and will be allowed to run
without being checked by the Trust Center security system. As the Dashboard.xls file comes from a
trusted source, allowing it to run without a security scan is safe. If you see the following Security
Warning message below the Ribbons when you open your Dashboard.xls file this message means a
Trusted Location needs to be created for the file.

) B AP )=
‘L‘ﬂ/'
— Haome Insert Page Layout Formulas Data
& Cut Arial -l A AT
=2 Copy
Paste B J U =

- # Format Painter = =

Clipboard (] Font

@ Security Warning Macros have been disabled. Options...

To create your Trusted Location follow these steps":

1.

o & D

10.
11.

Open the Dashboard.xls file

{ Ca
Click the Microsoft Office Button “** , and then click Excel Options

Click Trust Center and then Trust Center Settings
Click Trusted Locations

If you want to create a Trusted Location that is not local to your computer (i.e. not on your C:\
Drive), select the Allow trusted locations on my network (not recommended) check box

Click Add new location

In the Path box, type the name of the folder that you want to use as a Trusted Location, or
click Browse to locate the folder (e.g. the AIM folder you installed onto your C:\ Drive)

If you want to include subfolders as trusted locations, select the Subfolders of this location
are also trusted check box

In the Description box, type what you want to describe the purpose of the trusted location
(OPTIONAL)

Click OK (three times)

Save the file. Close and reopen it. You should no longer receive the “Security Warning —
Macros Have Been Disabled” prompt

Important Consideration When Creating Your Trusted Location

We strongly recommend that you do NOT make a location common to all computers (e.g. your
entire C:\ Drive, your Desktop or your My Documents folder) a Trusted Location. Doing so will
put you at a security risk (e.g. make you vulnerable to viruses).

9




Microsoft Excel 2010 Users

Unlike older versions of Microsoft Office Excel, those using Excel 2010 will need to create a Trusted
Location in order for the Dashboard.xls file to function properly.

What is a Trusted Location? A trusted location is typically a folder on your hard drive (C:\ drive) or
a network share. Any file placed in a trusted location can be opened and will be allowed to run
without being checked by the Trust Center security system. As the Dashboard.xls file comes from a
trusted source, allowing it to run without a security scan is safe. If you see the following Security
Warning message below the Ribbons when you open your Dashboard.xls file this message means a
Trusted Location needs to be created for the file.

- = 0 €3 T ——
& CIVE =
g Home Insert Page Layout Formulas Data R
p— Cut —
J & Arial 10 | A A = =
e 53 Copy -
aste F 1 = =
= # Format Fainter B I U == = =
Clipboard Font
1! Security Warning  Macros have been disabled. Enable Content

To create your Trusted Location follow these steps':

a k0 Dbdh P

10.
11.

Open the Dashboard.xls file

Click the File Menu, and then select Options

Click Trust Center and then Trust Center Settings
Click Trusted Locations

If you want to create a Trusted Location that is not local to your computer (i.e. not on your C:\
Drive), select the Allow trusted locations on my network (not recommended) check box

Click Add new location

In the Path box, type the name of the folder that you want to use as a Trusted Location, or
click Browse to locate the folder (e.g. the AIM folder you installed onto your C:\ Drive)

If you want to include subfolders as trusted locations, select the Subfolders of this location
are also trusted check box

In the Description box, type what you want to describe the purpose of the trusted location
(OPTIONAL)

Click OK (three times)

Save the file. Close and reopen it. You should no longer receive the “Security Warning —
Macros Have Been Disabled” prompt

Important Consideration When Creating Your Trusted Location

We strongly recommend that you do NOT make a location common to all computers (e.g. your
entire C:\ Drive, your Desktop or your My Documents folder) a Trusted Location. Doing so will
put you at a security risk (e.g. make you vulnerable to viruses).

10




Customizing Your Dashboard Settings

1. Open the Dashboard.xls file

2. Scroll down to the “Dashboard Settings”

Dashboard Settings

Delay Day Targets in Calendar Days No Show Targets as a Percentage
What is your target delay? 0 VWhat is your target Mo Show? I 0.0% _l
What is your tolerable delay? 7 Your tolerable No Show? 10.0%
What is too high? 21 What is too high? 20.0%
Activity vs. Demand Effective Date
What is a good difference? = The default date is today's date. If you change this date formula
What is a neutral difference? 1] you must change it each time the Dashhoard is used
What is a poor difference? -5 April 20, 2011

YELLOW fields are to be filled in with vour targets. PURPLE fields have formulas, but you can override these calculations by typing on top

3. For each of the measures represented on the Dashboard customize your team’s targets for
improvement

NOTE:
- The Yellow fields MUST be filled in by the user with the team’s target values

- The Purple fields, on the other hand, contain default formulas. In the event the calculated
values are not suitable users can key in their own values

4. Save your changes

11



Populating the Dashboard

IMPORTANT: The Dashboard.xls file can only be connected to one AlIMTracking.xls file at a time.
Take the following steps to download data from your AIMTracking.xls file into the Dashboard.xls file:
1. Ensure the Dashboard.xls file is named “Dashboard” exactly

2. Ensure the AlMTracking.xls file of interest and the Dashboard.xls file are save to the same location
(e.g. I Coam )

3. Ensure both files are open
4. In the AIMTracking.xls file press Alt+F8

5. In the Macro window that appears select the Dashboard.xIs!Data2Dashboard program

Macro name: i
Dashboard. xls!DakazDashboard L Run ] L
CleanUp ~

ComeTolew

Dashboard, xls|DatazDashboard

DownloadaIMData

{ | Dashboard. xls!Drop1Formulaz

A [Hide_Tearnwork_Tab

HideGenericl =
I | Hidemeneric2

4 |HideGeneric3

J{ | HideInkro

|| | HideServiceCycleData
1 | PopulatehlextSetup

| £

1 Macrosine | All Open Workbooks w

! Descripkion

Zancel

6. Press the Run button

7. The screen will flash while the program is running — once finished the Dashboard.xls file should be
populated

12



8. Select the provider of interest from the “values apply to:” field

(NOTE: you can change this field multiple times to view different provider’s data)

AIM Dashboard: Clinic Name

Values apply to: |Clinic

i i i Provider 1 ~
Time to Third Next Available Provider 2 v
Calendar Days Change Em\’?gerg Show Change
ATl ST rovider TS 7]
Most Recent week #NIA #NIA | provider & #MNIA
1 week ago #A #M/A | Provider 7 #HA
2 weeks ago #M/A #N /A LPravider 8 o L #NIA
3 weeks ago #A 3 weeks ago #NIA

Activity vs. Demand

Predicted Completed Week 2 weeks ago 3 weeks ago
Activity #NIA H#NIA #MIA HNA
Demand #NIA #NIA #NA ENIA
Status* #NIA #NIA #NIA #NIA

* This denotes the change in the team's status. Positive results mean a lower backlog, Negative results increased backlog

NOTE: your Dashboard Settings can be changed at this time if desired.

13



Interpreting the Dashboard Results

IMPORTANT - the purpose of the Dashboard.xls file is to provide a quick, high level analysis of your Team’s
improvement data. It’s not intended to replace the use of the AIMAnalysis file, which provides a more detailed
analysis. When used consistently, a Dashboard is a handy tool to quickly identify high level trends which can then be
investigated further.

NOTE: the screenshots below are from Excel 2007. If you're using an earlier version of Excel (e.g. 2003)
you'll note slight differences in the appearance of the dashboard (e.g. no change arrows).

Time to Third Next Available & No Show

What is the Most Recent Week Representing? 1 Week Ago etc...?

Time to Third Next Available No Show
Calendar Days Change Fercent Mo Show Change
Most Recent week: [} 120 4 80 Most Recent week: | 7.9% i 55%
1 week ago I 20.0 4 150 1 week ago I 13 4% 4 40%
2 weeks ago | 50 L 05 2 weeks ago I 9.4% 4 -26%
3 weeks ago | 45 3 weeks ago | B.8%

The Most Recent Week is determined using the Dashboard Setting — “Effective Date” field as a reference.
To ensure a complete weekly average is being calculated, the Most Recent Week refers to the complete
week prior to the “Effective Date”.

For example, if the Effective Date is anytime the week of October 11, 2010 the Most Recent Week will
represent the week of October 4, 2010.

Effective Date
The default date is today's date. If you change this date formula
you must change it each time the Dashboard is used
October 12, 2010

Subsequently the “1 week ago”, “2 weeks ago” and “3 weeks ago” averages are relative to the Most Recent
Week.

Using the same example above the corresponding dates would be:
- Most Recent Week - The week of October 4, 2010
- 1 Week Ago - The week of September 27, 2010
- 2 Weeks Ago- The week of September 20, 2010

- 3 Weeks Ago - The week of September 13, 2010

14




Activity vs Demand

Rather than representing weekly averages the Activity and Demand Dashboard values are weekly totals
(where the units are determined by each team - timeslots).

The Status® values are the difference between your team’s recorded weekly Activity and Demand totals. A

positive difference indicates a lowering of your backlog for the week of interest. A negative difference
indicates a backlog has increased for the week of interest.

What is the Completed Week Representing? 2 Weeks Ago etc...?

SA Activity vs. Demand
Predicted Completed Week 2 weeks ago 3 weeks ago
Activity 42.0 21.0 21.0 21.0
Demand 29.3 220 25.0 38.0
Status™ 12.7 -1.0 -4.0 -17.0
* This denotes the change in the team’s status. Positive results mean a lower backlog, Negative results increased backlog

The Completed Week is determined the same way as the Most Recent Week for Time to Third Next and No
Show. Subsequently, the totals for 2 weeks ago and 3 weeks ago are relative to the Completed Week.

For example, using the same “Effective Date” as above the corresponding dates would be:

Effective Date
The default date is today's date. If you change this date farmula
vou must change it each time the Dashbeoard is used
Dctober 12, 2010

- Completed Week - The week of October 4, 2010
- 2 Weeks Ago - The week of September 27, 2010

- 3 Weeks Ago- The week of September 20, 2010

15



What are the Predicted Totals Representing?

Activity vs. Demand

Predicted Completed Week 2 weeks ago 3 weeks ago
Activity 42.0 210 21.0 210
Demand 293 220 250 38.0
Status™ 12.7 -1.0 -4.0 -17.0

* This denotes the change in the team’s status. Positive results mean a lower backlog, Negative results increased backlog

The Predicted values are to help forecast how your backlog will change within the current week (i.e. the
week associated with the “Effective Date”)

As Activity is a retrospective measure the Predicted Activity represents your team’s Supply (i.e. what you
plan to do) for the current week.

The Predicted Demand is determined by averaging your last 4 weeks of Demand.

For example, using the same Effective Date as above the Predicted Activity and Demand would correspond
to:

Effective Date
The default date is today's date. If you change this date farmula

vou must change it each time the Dashbeoard is used
Dctober 12, 2010

- Predicted Activity - Supply for the week of October 11, 2010
- Predicted Demand - Demand averaged for the following weeks:
o The week of October 4, 2010
o The week of September 27, 2010
o The week of September 20, 2010

o The week of September 13, 2010

' Steps directly from http://office.microsoft.com/en-us/excel/HA100319991033.aspx
" Steps directly from http://office.microsoft.com/en-us/excel/HA100319991033.aspx

16
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